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< Answer all questions on THIS PAPER ITSELF.

Test 1
Complete the given sentences, Underline the most suitable words given within brackets.

The first one is done Jor you. _
L. Iwasvery (boredom, boring, bored) but I pretended I was interested in the
lecture, : _
2. One of my teeth is (lose, loose, loss). I can’t eat meat.
3. T always get (embarrassed, ashamed, shame) when I have to speak
- in front of a large crowd.
4..laman ' | (independence, independent, dependent) person. I don’t like to
rely on others. A .
5. "Ihis news might : (inflict, effect, affect) the outcome of the election. .
6. Canyou ’ (lend, borrowed, borrow) me one of your pens? .
(1x5=Total ........../5)

Test 2
Read the following sentence and fill in the blanks, Use the words given in the box. There’s one extra
word. The first one is done for you.

mine, here, us, them, him, it, theirs

@) Where’s Rajeev" I v&;ant to talk to him

(i) We're gomg to the cinema. Do you want to come with - ?
~(iii)  Who is that woman? Why are you looking at ?

(iv)  Inever go to parties. I don’t like

(v). Isittheir car? No, .____isgreen
(vi)  Whose hair band is this? It’s

592 (Ix5="Total ......... /5)
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Test 3~
Look at the pictures. Write what each student has done. Each sentence should have at least five

words. The first one is done for you.

1) Sudesh has graduated fromthe
University of Colombo -
L " (1'x5=Total .......;../5)
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Test4

b4

‘Read the CAPITIONS and the ADVERTISEMENT given below.

Match the captions with the advertiseinents by writing the correct letter in the box. The first one is

done for you.

Captions
a) Educational .- d) Musical instruments
b) Entertainment e) Photographic edﬁ‘ipment
¢} Lost and found f) Petsfor sale
Advertisements
1) Kittens éndp}lnnies :
German Shepards, 2) Canonand Konica |
Persian cats, - New model V/Camera
Dalmatians’ with additional Equipment
T.L.Peris - Dehiwala f C.P.Liyanage — Wattala .
‘Tel: 2431827 Tel: 2581922
. 4) London (A/L) ~"Bioscience;.
3) TASSIO brand new organ Physical Science,
Double key board Economics, Literature
Tania Anderson Beginsin October
Park Rd, Colombo 05 AIS International Sghoo] .
Tele: 077712345 Colombo 03.
» 6) Small, black and -
S) For weddings and Parties write dog,
“Enriques” with a red collar
One boy orchestra named “Lassie”
Tel: 078652211 Finder rewarded Rs.8,000/-
' Tel: 075331502
(1x5=Total ........../5)
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TestS

RBad the following conversalwn and ﬁll m the blanks in ‘the summary glven below

The first one is done for you. i {
Mithini . Mother. my friend Mithini will come w1th her mother to hand.over my notes.
: But I have to go to school today. -
Mother : 'It’s alnght. I’m at home today. Tell me, how does she look hke?
. Mithini  : She has long wavy hair. Mlthmms siot all and not short She is about 165
N s cenptimeters in height. She'is fair in complean. o
- Mother - o Well, what about her mother‘? .
Mithini : P’ve seen her very often Sheisa small built and hght-skmned lady Her |
mother is m her early 4OS and her hair is going grey.
Mp_thcr : Alnght dear.- I'will welcome them.
One can easily identify Mithini and her mother. Mithini is (1) ___  height.
She is a (2) __fair _ girl. If you look for the appearance of her mother, she is small
3) _ ad(® _ . Mithini’s mother is (5)
aged and has (6) " hair | |
- (1 x 5=Total .......... /5)
Test 6 o ™ ,_-

You received the following note from your friend, Semini. -~

Dear friend,

. Let’s go to the book fair at the BMICH this Saturday. My mother will
accompany us. Can you come? :

Semini

Semini’s note doesn’t tell you anything much. You need to ask some questions. Write your reply. Include the
following.

- thank her for the note
/ where to meet and the time

ask questions about 4 time she hopes to spend there

express willingness to go there as your mother has given permission
Use about 40- 50 words.

1
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- Test 7 , _ | - | . .. | E

Read the folldwing text and answir the questionsgiven below.

After an absence of thirty years, I decided to visit my old school again. | had expect_ed to
find changes, but not a completely different buildings, As I walked up the school drive, |

wondered for a moment if I had cyme to the right address. The grimy, red - brick fortress with

its tall windows that had looked down grimly on the playground had been swept away. In its-

place stood a bright, modern block raised from the ground on great concrete pillars. There was
a well-kept lawn where previouslythere had:been untidy gravel yard.

I was pleased to find that it was the interval and that the children were all in the
playground. This would enable me ‘0 meet some members of staff. On entering the building, I
was surprised to hear loud laughte: coming from what appeared to be the masters’common
room. | could not help remembering the teachers in my time, all dressed in black gowns and
high collars. And above all, I recalled Mr.Garston, the headmaster, who had imposed iron
discipline on staff and pupils alike. I knocked at the common room door and was welcomed by
a smiling young man who introduced himself to me as the headmaster. He was dressed casually

in a sport jacket, and his cheerful manner quickly dispelled the image of Mr. Garston. After | -

~ had explained who I was, the headmaster presented me to the teachers, and said he would take
me round the school. S :

Here the biggest surprise of all was in store for me. Gone were the heavy désks of old

with their deeply carved initials; gone, too, were the gloomy classrooms with their ink -

.;stained, dark brown walls, and their raised platforms for the teachers. The rooms now were

- gaily painted in contrasting colours, and the children, from sitting rigidly in their places,
seemed almost free to do as they liked. I looked at them with envy as I remembered how, as a
child, I had gazed at the blackboard, afraid even to whisper to my neighbor.

1) - Write two things that writer could see at school then.

-

i

2) At what time did he visit the school?

3) What were the most clear cut differences at school then & now?

4) . The underlined phrase in paragraph 2 could be replaced by
a) Iwasn’t able to assist '
b) It was no use
c) Iwasn’t able to prevent myself from
d) Iwasn’t able to remember

5) Find & word in the last paragraph which means “Stiffly”

| (1x5="Total......... /5)
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Answer all questions on THIS PAPER ITSELF.
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1]

The following sentences are taken from an article correct the mistake in the following
sentences and rewrite them. There is a mistake in each sentence.

(i)  Hans Christian Anderson wrote many humours stories.

(i)  “The Emperor’s n-ew‘ clothes’ is very popular between children. |

(iii) © Hans Christian’s father was a poor shoes maker.

(iv)  He wrote much stories for kids.

(v)  This sirhpl‘e stories have been read all over the world.

Tact 10

A VOV AV

Select a word from the box which has a similar meaning to the phrases given within brackets.
Write it in the space given. There are three extra words.

cover, directly, current, insert, connect, supportive, easily,
“coordinate, prepare

The Computer
*On the Insert tab, the galleries include items that are designed to (i)

(negotiate with other people to work together effectively) with the overall look of your
document. You can use these galleries to (i) __insert _ (add something into something else)
tables, headers, footers, lists, (iii)
pages, and other document building blocks. When you create pictures, charts or diagrams,

(put something in front of so as to protect)

they also coordinate with your (iv) (being used now) documents look.

You can (v) (without difficulty of effoft) change the formatting of
selected text 1n the document text by choosing a look for the selected text from the Quick
Styles gallery on the Home tab. You can also format text (vi) (exactly in a
particular position) by using the other controls on the Home tab. (1x5="Total ......./ 5)

’ .
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.o Test1l ' S
Complete the following passage. Use the words given below it.

B PR B L

The Egyptian or the Nile Valley civilization developed, as the name suggests, along
the banks of the river Nile in Egypt. Its long, narrow flood plain was a magnet for (1)
' __, attracting people, animals and plants to its banks, and

Q). " -deal conditions for the development of stable communities.
Seen (3) a gift from the gods, the annual fooding of (4

river deposited nutrient rich silt over the land, (5)
ideal conditions for growing wheat, flax ated other-crops.
Evidence suggests that the region was inhabited as far (6) __-

" Gate, the oldest

700,000 years ago by Neolithic and Paleolithic Man. (7) _ e e ;
tools found in the lower Nile (8) v have been found in and nearthe cliffs
of (9) Simbel, just across the river from where, millennia later II
L (0) ' descendants of these people would build the temple of Rameses 11
F115 T evidence indicates they are around 700,000 years old, giving
12) _ g fairly good estimate as to when a StoneAge (13) -~ -
was living in the area. It is believed that (14) ' nomadic hunters setiled in
the valley and over the course of time, began to grow crow crops to supplement their food
supply. '

the, geological, a, black, abu, valley, people,
nomadic, life, creating, the, providing, as, to

i

SR

o Testl2

Given below is a conversation Ruwini had with Vinuri complete the following extract from
what Ruwini told another friend. ' ‘ ' S

Ruwani - What are you do_igg? o

Vmun A I’m'm»aking a card for my sister’s birthday
Ruwini - Rlooksmiee!

Vinui - 1didwtspend a cent on it

Ruwini - So, what did you use to make it?

Vinuri - T used pressed flowers and leaves

Ruwini i, it;éé;giﬁnply awesome.

Vinuri is busy in her class now. She says that (1) __she is making a card for her sister’s

birthday. I tok}‘ that (2) : nice. But She says that she (3)
a cent on it. So I asked what she @ make it.
She says ‘that she (5) pressed - flowers and leaves. 1 told that it (6)
awesome.
592 : " (1 x 5=Total ....... /5)
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" e Testld ' ' "

Study the two pictures given and select ’théw'seri'ten'ce_s which describe each picture. Write the
correct letter in the relevant column. One is done for you.

a.
b.

c.

d.
e.
f.
g
h.

1.

3 | Grade 13 Economic ~H

i
. White board is being used for a purpose at the moment. - . S T

Picture A ' ‘ Picture B
] ' © ALWAYS BF PREPATRED

FONs e PO B g 5 BOLE AR S0 4AS W

‘-"C.'-':-’?"-— ¢ BEwh Wy

. Two windows which are closed, can be seen.

The cl2ssroom is arranged in a half circular way to focus the central figure.
1t seems that small groups are arranged to do actives.
It is clear that the front wall has been used as a notice board.

This class room belongs to the primary section.

A notice board is hung on the left wall of the class room.

Students have not been trained to hang their water bottles in the rail«: "

It is obvious that students are self-motivated by the saying that is stuck on the wall.

Book shelves are kept in different places so that students can access easiiy:

It seems that a presentation is being carried out.

Pictulje A Picture B
a

e (12 x......=Total .../ 5)
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o Testld

(a) Youhad the Prize Giving in your school recently. You received many certificates and .
- medals being the grade first. Describing the occasion, write a letter to your aunt who is
living abroad. -

Mention the following,
- when and where it was held
- who the Chief Guest
- - how you felt on that day
. - what you have determined to doin futm'e

o

Use about 100 words
OR T
(b) The following pie chart shows the different types of TV programmes the chlldren hke to

watch-during their hohdays Study the chart and write a paragraph describing it. Use
- about 100 words. .

" Musical L Mowes-& cartoons
e - ‘ . Educatlonal_
_ . Movies & ¢ Documentaries

cartoons e Sports

o 30% e Musical
S it Educational
N Pocumentaries | 20%

i
'%
=4 WEEEC T AR (CLOM ... .. =Total ......./ 10)
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Read the foilowing text and answer the questions.

Colour Symbolism

Why is pink often througt to be a colour for girls and blue a colour for boys? The answer ;
depends mainly on personal experiences and cultural background because coiour means diiicreii

things to different people around the world.

The meaning of a creation colour may change depending on your culture. Green is one of
these colours. It is an important colour for Mulims and représents paradise. To the Egyptians, green
is a holy colour and the hope and joy of spring. Meanwhile in Japan, green means long life. It is said
that green relaxes the mind and body, relieves pain and has a great healing power. In fact, people
who work in green environments have been found to have fewer health problems. The colour green
also helps depression. When a bridge in London was painted green, the number off people jumping
of the bridge and killing themselves, dropped by 34 percent'

For many people red is a favourite colour It isa colour of love, enegy, fire, blood and war. In
many cultures red is connected with money and good luck. In Hindu, Islamic and Chinese culture red

is a traditional colour that brides. wear, In China it is also the colour of the Chines New Year, where

houses are decorated in red and. chlldi'en are given money in red envelops. In addition, many
restaurants decorators believe that red makes people feel hungry and customers eat more if red is
included in the restaurant decor. Red also catches a person’s eye quickly and is often used in

commercial websites to encourage people to make a purchase. It is a trick played by them. .,

Like red and green, blue is another universal colour of water and the sky. In Greece, people
believe that wearing blue give you protection against evil. People who believe this wear a blue
necklace or bracelet. Blue like green is another calming colour and it has been found that people
sleep better in biue rooms. However, some people suggest that unlike red, blue makes Ppeople eat
iess. So, if you arc thinking of losing weight blue plates can help you to do this as we seem to eat less
when eating from them.

The next time you are deciding on what to wear or what colour to decorate your room, think

about the colour carefully. Not only may your colour choice mean something different in different in -

cultures, it may also make you or someone nearby, think, feel and react differently.

- Adapted from “A Good Read” Book 3 by Carlos Islam and Carrie Steenburgh

(1) Say whether the following statements are True or Falls by Wﬁting T or F against them.

) It is a universal belief that pink is a colour for girls and blue for boys.

(i)  The Japanese think you can live forever if you wear green

‘(i) Tthas been seen that green can often help people feel less unhappy

(iv)  Hindus believe that read is a lucky colour

6oz (12 x......=Total ....../ 2)
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(2) Write two-of the ways in which the colour green has a ;;bsitive effect on your body

(1 mark)

(3) Under line the correct answer. 3
¢ People who work in green environments have been found to have fewer heaith probiems

" () Itis not good to work in a green environment as it supports fewer health problems.
(i) Health problems like fever are found in the people who work in green environments
(iii) Working in green environments reduces health problems _

- (1 mark)
" (4) The two adjectives that describe the colour blue are and -
(5) Find the words from the passage which have the same meaning as the followihg. )
ache e ponder . (1mark)
(6) Find the words from the passage that have the opposite meaning to the following. - :
rarely ’ e i {1mark)
N What do the following pronouns referto , '
it (in line 5) T o
them = (in line 17) e (M2 x 2= 1 mark)
_ - - §mark)
Test 16

B ¢ Z VORI . % RPN 7 | PP
Write on one of the following. Usc about 200 words.

(2) An essay on the following topic. T e
-% Challenges make life successful.” -

» Types of challenges peoples face - at childhood, aduithood and at old age™ =

» Training received to face challenges - at home tarough activities done with parents’ and
guidance through school activities

» Qualities or characteristics - You should develop to face challenges *

»  Effects of challenges on life - When faced successfully

" You mayinclude: - e

() Write the speech you would make at the English literary Association on the topic “Reading is

fun” Yoh may include,
_ (i) Type of reading materials
- (i) Importance of reading -

o
O
w
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' The PSU carried out a special programme to help the flood victim in your school. Write an
a;ticle to a newspaper regarding the above programme.

(c) lmagin.e you are the secretary of your school Public Service Unit.

Mention;

how you started the programme
what was collected

who helped you
how you felt after it

(d) Complete the following si;ory.

It was a gloomy day. I was in my small room. My sister came into the room smiling and

saying ‘I have a secret......ccco0ee o

(CLOM........ = Total ......./ 15)
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